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EXECUTIVE SUMMARY 

The purpose of Phase 1 of this research project was to summarize existing nondestructive test 
methods that have the potential to be used to detect materials-related distress in concrete 
pavements. The purpose of Phase 2 of this project was to utilize information from two 
techniques, ground penetrating radar (GPR) and visual inspection via the pavement profile 
scanner (PPS), in proof-of-concept trials. 

For this study, GPR tests were carried out on a variety of portland cement concrete pavements 
and laboratory concrete specimens. Three different systems and seven different antennas (all 
ground-coupled, with center frequencies ranging from 400 to 1500 MHz) were used in the study. 
One of the systems was a state-of-the-art GPR system that allowed data to be collected at 
highway speeds. The other two systems were less sophisticated systems that were commercially 
available. Surveys indicated that the higher frequency antennas were capable of detecting 
subsurface distress in two of the three sites investigated. However, the GPR systems failed to 
detect distress in one pavement (Highway Stub P-73) that exhibited extensive cracking. 
Laboratory experiments were conducted to isolate the reason(s) for the failure to identify distress 
in the cracked concrete. The results of the experiments indicated that moisture conditions in the 
cracked pavement site are the most probable explanation for the failure to identify the distress. 
The most accurate surveys need to account for moisture-related artifacts in the pavement slab. 
However, it is also important to realize that once the pavement site exhibits severe surface 
cracking there is little need for the GPR method, because the method is primarily used to look 
below the surface of the concrete to detect distress that is not observed via visual inspection. 

Two visual inspection surveys were conducted during this study. Both were conducted by 
Mandli Communications, Inc., and/or Iowa Department of Transportation (Iowa DOT) 
personnel. The first survey was conducted in July 2003 and the second was conducted in July 
2004. The surveys were conducted using the Iowa DOT video log van, which had been fitted 
with additional equipment provided by Mandli. The first survey was limited to an extended 
demonstration of the PPS system. The second survey utilized the PPS system in conjunction with 
a downward imaging system (line scan camera) that provided high-resolution pavement images. 
However, the lighting system was not functional during the study so the image quality was not as 
good as that which could be expected from a fully functional system. Experimental difficulties 
were noted during both studies; however, enough information was extracted from each survey to 
consider them both successful in identifying distress on the surface of pavements. 

The results obtained from both GPR testing and visual inspections were helpful in identifying 
sites that exhibited materials-related distress. Hence, both were considered to have passed the 
proof-of-concept trials. However, it is important to note that neither method can currently 
diagnose materials-related distress. Rather, both techniques only detected the symptoms of 
materials-related distress; the actual diagnosis still relied on coring and subsequent petrographic 
examination. Both technologies are currently in a rapid state of development and the future 
appears bright. The limitations may be overcome as the technologies advance and mature. 
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INTRODUCTION 

Background 

Many pavement and materials engineers examine a distressed pavement and come up with 
different theories as to the cause of the distress. The concrete industry continues to study how 
materials and construction techniques can be combined to enhance the performance of portland 
cement concrete (PCC) pavements. In one such effort, Michigan Technical University is 
developing a systematic approach to detection, analysis, and treatment of materials-related 
distress (MRD). This approach has been thoroughly documented in a recent report (Van Dam et 
al. 2002). The following definition of MRD from the report was used in this study: 

In general, MRD refers to concrete failures that are a direct result of the properties of 
the materials and their interaction with the environment to which they are exposed. In 
this sense, these failures are differentiated from others that may be most closely 
associated with inadequate design for the traffic and environmental loading or the use 
of improper practices during pavement construction (Van Dam et al. 2002). 

A method (or methods) is (are) needed for evaluating and quantifying the amount of distress or 
deterioration present in existing pavement slabs. Since materials-related distress might begin at 
the base of the slab, evaluation is difficult and commonly subjective. Currently, petrographic 
examination of core sections is the most common technique used (ASTM 2002). However, it is 
also time consuming and semi-quantitative (or opinion-based in most instances), and site 
selection commonly depends on observations of surface features. Hence, the goal of this research 
project was to research and develop nondestructive testing (NDT) methods that have the 
potential to enhance the in situ detection of materials-related distress. 

Phase 1 of this project concentrated on conducting a literature survey directed at identifying 
NDT methods that would be best suited for the evaluation of pavements (Schlorholtz, Dawson, 
and Scott 2003). The following series of ground rules was defined to help restrict the potential 
solutions considered: 

•	 The techniques should be of a global nature (i.e., able to inspect large areas 
efficiently). 

•	 The techniques should have a minimal impact on traffic flow. 
•	 The techniques should be relatively easy to interpret. 

The final methods identified for further consideration are summarized in Table 1 (based on ACI 
2002). Further selection criteria were applied and the two methods that were selected for proof-
of-concept field trials were inspected visually and with ground penetrating radar. Visual 
inspection was supplemented by modern pavement management techniques to make the method 
more robust. 
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Table 1. Nondestructive test methods applicable to this study 

Test method 
Visual inspection: identification and 
categorization of distress 

Strengths 
Sensitive to fine details 

Weaknesses 
Subjective, often difficult to 
quantify 

Impact-echo: locates delaminations and 
voids; measures element thickness 

Access to only one face is 
required; equipment is 
commercially available, 
capable of locating a 
variety of defects, and does 
not require coupling 
materials 

Experienced operator 
required; current 
instrumentation limited to 
testing members less than 
two meters thick 

Spectral analysis of surface waves: 
determines the stiffness profile of a 
pavement system and determines depth of 
deteriorated concrete 

Capable of determining the 
elastic properties of layered 
systems, such as pavements 
and interlayered good- and 
poor-quality concrete 

Experienced operator 
required; involves complex 
signal processing 

Infrared thermography: locates 
delaminations or voids 

Global technique applicable 
to large surveys; results 
indicate the percentage of 
deteriorated areas in the 
survey region 

Equipment is expensive; 
test response varies with 
environmental conditions, 
so testing may be restricted; 
cannot measure depth or 
thickness of a subsurface 
anomaly; experienced 
operator required 

Ground penetrating radar: locates voids, 
metal objects, and areas of high moisture 
content 

Global technique applicable 
to both large and small 
surveys; sensitive to the 
presence of embedded 
metal objects; able to 
penetrate concrete-air 
interfaces; sensitive to the 
presence of moisture 

Region irradiated by the 
antenna is limited to cone-
shaped volume directly 
below antenna; cracks not 
easy to detect unless 
moisture is present; 
experienced operator 
required to operate 
equipment and interpret 
results 

Phase 2 Purpose and Scope 

The overall goal of this project was to research the use of nondestructive test methods to simplify 
the in situ detection of materials-related distress in portland cement concrete pavements. The 
scope of this project was limited to concrete pavement sites located in Iowa. The test results 
obtained from Phase 1 indicated that additional work was needed to study the ability of GPR to 
detect materials-related distress. The GPR technique successfully identified aggregate-induced 
cracking (frost attack or durability cracking) in two of the pavement sites in this study. This was 
accomplished even though the symptoms (i.e., cracking and staining) were not evident at the 
pavement surface. Hence, the GPR technique contributed information about distress that was not 
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readily available from visual inspection. However, the GPR study failed to identify any distress 
in a severely map-cracked pavement site that had been diagnosed with premature distress. This 
anomaly suggested that additional research was needed. In addition, difficulties related to 
firmware and software development for the Mandli Communications, Inc., pavement profile 
scanner (PPS) had been resolved and that the system was finally available for field testing. 

The specific objectives for Phase 2 are summarized as follows: 

(1) Evaluate how GPR antenna type, configuration, and survey vehicle speed influence 
the detection of materials-related distress. 

(2) Re-evaluate the P-73 test site (premature distress cracking) to determine why the GPR 
method failed to indicate distress. Special attention will be given to site variables that 
influence GPR response (e.g., moisture content or the presence of deicer salts) and 
that may have obscured the signal from the slab. 

(3) Evaluate the visual inspection system to determine whether it can be used to locate 
and quantify surface distress effectively. 

(4) Evaluate the feasibility of combining the results from the GPR and the visual 
inspection systems to simplify the visualization of pavement distress features. 
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RESEARCH PLAN 

The research plan for Phase 2 consisted of a series of tasks aimed at addressing the four 
objectives listed above. Most of the proof-of-concept GPR field surveys had been completed 
during Phase 1. However, additional GPR studies were conducted to clarify the interpretation of 
specific types of deterioration. For example, alkali-silica reaction (ASR) is a common cause of 
pavement distress whenever alkali-sensitive aggregates are incorporated into pavements without 
proper mitigative measures. Experiments were designed to check the effectiveness of GPR in 
locating ASR-related cracking. These laboratory experiments were conducted on both mortar 
and concrete specimens.  

The research tasks for this project are summarized below: 

•	 Meet with consultants to review project goals and gather information about research 
and equipment needs for Phase 2. 

•	 Select field sites for the visual inspection studies. 
•	 Select and order GPR equipment for the additional experimental work. 
•	 Arrange field work for the visual inspection studies. This was coordinated with the 

Iowa DOT and Mandli Communications, Inc. The Iowa Department of Transportation 
(DOT) video log van was fitted with a pavement profile scanner and downward 
imaging cameras for this task.  

•	 Conduct studies to evaluate the ability of GPR to complete objectives 1 and 2 above.  
•	 Analyze data obtained from the visual inspection studies. Compare and contrast ways 

in which the information could be combined with GPS information. 

The research plan was severely delayed by technical difficulties with the PPS. The details 
pertaining to the delays will be described later in this report. In addition, the purchase of the 
GPR system was delayed for about six months at the recommendation of the GPR consultant. 
Additional time was needed to evaluate the variety of available systems (hardware and software). 
This caused the delivery of the GPR system to be delayed until approximately March 2004. 
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EQUIPMENT AND PROCEDURES 

The proof-of-concept testing evaluated several different ground penetrating radar systems (and 
associated software packages) and the pavement inspection system supplied by Mandli 
Communications, Inc. The visual inspection system consisted of an Iowa DOT van equipped 
with a pavement profile scanner, a downward imaging system, and the normal videolog system.  

GPR Study 1 

The preliminary ground penetrating radar study was conducted by Iowa State University 
personnel. The study employed a Sensors & Software, Inc., pulseEKKO 1000A system that was 
controlled by a laptop computer. The computer was connected to the hardware using a pE 1000 
high speed kit. Two different ground-coupled antennas (center frequencies of 900 and 1,200 
MHz) were used during the study. The system was towed behind a slow moving vehicle, and 
hardware data collection constraints limited the speed of the vehicle to about five mph. The 
antenna was automatically triggered using a wheel odometer. The data collected during the 
fieldwork was evaluated using the comprehensive software package provided by the vendor 
(Win EKKO Pro PC, EKKO 3D, EKKO Mapper, and EKKO Pointer). 

GPR Study 2 

The second GPR study was conducted by Mike Scott of MGPS, Inc. The study employed a 
Geophysical Survey Systems, Inc., (GSSI) SIR-10 A+ GPR system. Three different ground-
coupled antennas (center frequencies of 400, 900, and 1,500 MHz) were used for the study. The 
system was capable of collecting high-resolution data at highway speeds (55 to 60 mph).  

GPR Study 3 

The third GPR study was conducted by Iowa State University personnel. The study employed a 
GSSI SIR-20 GPR system. Two different ground-coupled antennas (center frequencies of 900 
and 1,500 MHz) were used for the study. This dual-channel system is capable of collecting high-
resolution data at highway speeds. However, FCC emission regulations for ultra-wide band 
transmitters restrict the maximum data collection speed of the system to about 10 to 15 mph for 
high-resolution data collection. This system is configured with SIR-20 data collection software 
and RADAN 5 data analysis software. The GPR system is stored in a small trailer; the trailer 
also serves as the data collection platform for the system. The trailer is basically a motorcycle 
trailer that can be towed by any size of car or truck. The trailer is also light enough to be pushed 
by a single person so that short segments (bridges, parking structures, etc.) can be collected at 
very slow speeds for maximum resolution. A wheel encoder is used for triggering the GPR 
system at specific intervals during the data collection process. The standard operating procedures 
developed for GPR surveys are summarized in Appendix 1. The procedures describe how to 
collect both linear and three-dimensional surveys. However, in most instances the three-
dimensional surveys are too time-intensive for routine work. A three-dimensional survey will be 
presented later in this report. 
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Laboratory Investigations 

Several concrete and mortar mixtures were made to investigate specific features of the new GPR 
equipment. As mentioned above, the field studies (specifically those at Highway Stub P 73) 
indicated that it was difficult to measure distress (i.e., cracking) in certain instances. Experiments 
were designed to study this issue in more detail. The experiments evaluated the detection of 
cracking in concrete caused by ASR, the detection of rebar in concrete, and the detection of 
cracking in mortar caused by ASR. The concrete specimens were also used to evaluate how 
different antenna types and configurations influenced the detection of ASR-induced cracking. 

Two concrete slabs were constructed using locally available materials. The slabs had nominal 
dimensions of four ft x three ft x one ft (length, width, thickness). One of the slabs contained 
reinforcing steel located at a specific depth and orientation. The other slab contained a very 
reactive aggregate at only the middle of the specimen (at a six to eight-inch depth). The reactive 
aggregate used in the study was a fused quartz (passing a #4 but retained on a #8 sieve); this 
aggregate had been used in past experiments and was found to be considerably more reactive 
than Pyrex glass. Cores (nominal diameter of four inches) were extracted from the concrete slab 
after approximately six months of curing at ambient conditions. The cores were examined 
petrographically to check for the presence of ASR-induced cracking in the aggregate particles. 
GPR measurements were conducted on the slabs several times during the experiment. 

Two mortar slabs were constructed using high-alkali portland cement, ASTM C 109 graded 
standard sand, and fused quartz (same particle size as that used in the concrete slabs). The 
nominal dimensions of the slabs were 16 in. x 12 in. x 7 in. (length, width, thickness). One of the 
mortar slabs contained only graded standard sand, and was therefore considered the control 
specimen in the experiment. The second slab contained an aggregate composed of 20% fused 
quartz and 80% graded standard sand. GPR measurements were conducted on the slabs several 
times during the experiment. In addition, mortar bar specimens were molded from excess mortar 
obtained from each mixture; this was done to monitor a rough estimate of the expansion of the 
mortar slabs versus time. The mortar bar specimens were sealed in storage containers and cured 
at two different temperatures. One set of mortar bars was cured at an ambient temperature (75˚F) 
while the second set of mortar bars was cured at 100˚F. 

Visual Inspection Study 

Phase measurement laser radar (Ladar) technology has been developed by Phoenix Scientific, 
Inc. (2003). The device has very promising technical capabilities (very precise distance 
measurements at extremely high sampling rates) and has been incorporated into the PPS 
developed by Mandli Communications, Inc. (2003). The PPS system has the potential to collect 
transverse (rutting), longitudinal (faulting), and distress (cracking) profiles while traveling at 
highway speeds. The technology is very new and the hardware and software are still being 
actively developed; however, the device was available for testing. 

The concept behind the PPS system can be briefly summarized as follows (Mandli 2005). A 
modulated laser beam is reflected off a rotating mirror. The beam strikes the pavement surface 
and is reflected back at the rotating mirror; however, the reflected beam has been phase-shifted 
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(i.e., Doppler-shifted) so that it exhibits a time delay relative to the incident laser beam. The 
detector measures the phase shift and the signal intensity at each point along the scan line. Since 
the mirror is spinning at about 167 revolutions per second, the laser beam is able to make about 
1,000 scans per second. The system is composed of both hardware and software components, 
shown in Figure 1 (Mandli 2005). The hardware components consist of an amplitude modulation 
(AM)-modulated laser, a rotating polygon mirror, detector optics, and phase measurement 
electronics. Data is processed after the information has been collected and saved to fixed storage; 
calculations include the normal pavement engineering information (e.g., International Roughness 
Index, rutting, etc.). For the purpose of this study, the system was used to scan for distress 
features, such as fine cracking that is a common symptom of materials-related distress. 

Mandli Communications, Inc. was contacted to perform an extended field demonstration of their 
pavement evaluation system. The initial system consisted of a PPS integrated into the existing 
Iowa DOT video log van. See Figure 2 (Smadi 2005). A second system, considerably more 
robust than the first, was developed under an alternate FHWA program (Smadi 2005). The 
system consisted of a PPS and a downward imaging system (dual line-scan cameras, but without 
a lighting system). Again, the systems were integrated into the Iowa DOT video log van. 

Laser Detector 

Polygon 
mirror 

Begin 
Scan 

End 
Scan 

Hardware 

Modulator 
Optics 

Phase 
Measurement 
Electronics 

Center line Fog line 
Right 
Shoulder 

Incident Beam 
is modulated to 
produce the 
"reference" signal 

Return Beam 
contains reflected 
signals from the 
pavement in a "Cosine 
Distribution" 

Over 1000 discrete points are generated per scan of a 14 ft lane. Some are the 
"housekeeping portion".  In "Full resolution mode" 942 points are processed in 
data conversion. The data pts are furthest apart at the pavement edges 
and closer in the center of the pavement lane. 

Pavement 

Figure 1. Illustration of the main features of the PPS system 
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Figure 2. PPS device mounted on the Iowa DOT video log van  
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FIELD SITES 

GPR Sites 

Four sites were selected for the GPR proof-of-concept testing. The sites were chosen based on 
prior information about the sites. Site details are summarized in Table 2. Two sites exhibited 
aggregate-related distress, one site exhibited paste-related distress, and the final site exhibited no 
distress (control section). The site that exhibited paste-related distress was P 73, a stub from a 
section of US 20 (previously called Highway 520) that was constructed in 1987. That particular 
section of US 20 was covered with an asphalt overlay in 1996 because of premature distress. The 
stub exhibited severe map cracking that was similar to that observed on US 20.  

Table 2 Field sites evaluated using GPR equipment 

Site Location DOT designation Pavement details Distress type 
1 US 63, Poweshiek County FN-63-4(6)- -21-79 Constructed 1980 Aggregate related 

2 Hwy 146, Poweshiek County FN-146-2(6)- -20-79 Constructed 1983 Aggregate related 

3 P 73, Webster County County road Stub of Hwy 520 Premature distress 

4 Hwy 175, Hamilton County F-175-7(13)-20-40 Constructed 1980 None observed 
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Visual Inspection Sites 

Eleven field sites were selected for proof-of-concept testing. The sites were chosen based on 
prior information about the sites. Site details are summarized in Table 3. Note that some of the 
sites were contiguous stretches of pavement listed under different DOT designations because 
they were paved at different times. Hence, the 11 sites could be listed under the 8 locations given 
in Table 3. All sites had been evaluated via field survey and petrographic examination during 
prior research (Schlorholtz 2000). Note that the first four locations match the sites used in the 
GPR proof-of-concept trials. 

Table 3. Field sites selected for visual inspection proof-of-concept tests 

Site Location DOT designation Pavement details Distress type 
1 US 63, Poweshiek County 

(SB, MP 110 to 109) 
FN-63-4(6)- -21-79 Constructed 1980 Aggregate-related 

2 Hwy 146, Poweshiek 
County (NB, MP 20 to 21, 
driving lane) 

FN-146-2(6)- -20-79 Constructed 1983 Aggregate-related 

3 P 73, Webster County County road Stub of Hwy 520 Premature distress 

4 Hwy 175, Hamilton County 
(EB, MP 156 to 158.3) 

F-175-7(13)-20-40 Constructed 1980 None observed 
control site for GPR 

5 I-35, Story County (NB, 118 
to 126) 

IR-35-5(45)111 
IR-35-5(40)121 

Constructed 1988 
Constructed 1985 

Control 
Premature distress 

6 US-61, Scott County FFD-561-1(6)-2N-82 Constructed 1981 Control (but some 
base cracking) 

7 US 218, Johnson County F-518-4(12)-20-52 Constructed 1983 Premature distress 

8 I-80, Poweshiek and Iowa 
Counties (EB, MP 193-221) 

IR-80-6(136)193 
IR-80-6(126)209-12-48 
IM-80-6(175)220-13-48 

Constructed 1990 
Constructed 1988 
Constructed 1997 

Control 
Aggregate-related 

Control 
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RESULTS AND DISCUSSION 

Summary of GPR Survey Results 

The results of GPR surveys on the various field sites are summarized in Table 4. Extensive 
descriptions of the individual survey results were given in the Phase 1 report (Schlorholtz, 
Dawson, and Scott 2003), and therefore only a brief summary will be given here. Most of the 
discussion will pertain to the difficulties with interpretation listed earlier in this report. The test 
results from Highway Stub P 73 were consistent with the different antennas and antenna 
configurations used in this study: each experimental setup failed to detect the severe distress that 
was visually evident in the pavement slab. (The most plausible reasons for this failure will be 
discussed below.) Hence, the use of GPR was considered successful in the proof-of-concept 
testing in three out of the four sites evaluated. 

Table 4. Summary of GPR survey results 

Site Location Distress type Summary of proof-of-concept testing 
1 US 63, Poweshiek 

County 
Aggregate-related GPR indicated extensive cracking at the base of the 

slab. Distress was concentrated at the joint region of 
the pavement slab. Depths compared well to 
measurements from cores extracted from the site. This 
was confirmed as aggregate-related cracking by 
petrographic techniques. The distress was evident at 
speeds from 5 to 50 mph.  

2 Hwy 146, Poweshiek 
County 

Aggregate-related GPR indicated moderate cracking at the base of the 
slab. Depths compared well to measurements from 
cores extracted from the site. This was confirmed as 
aggregate-related cracking by petrographic 
techniques. The distress was evident at speeds from 5 
to 35 mph.  

3 P 73, Webster County Premature distress GPR testing was unable to locate the distress in the 
pavement slab. The surveys were conducted with five 
different antennas and several different 
configurations. Speed of data collection was varied 
from walking (about 3 mph) through 20 mph with 
little success. The most plausible explanation is that 
the GPR signal is complicated by the presence of 
water in this severely cracked slab. 

4 Hwy 175, Hamilton 
County 

None observed GPR testing was unable to locate the distress in the 
pavement slab. This was in agreement with the 
petrographic information, which indicated no distress. 
Vehicle speed ranged from 5 to 55 mph. 
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The results of the laboratory studies on the various slabs are summarized below. The laboratory 
investigations were conducted to clarify specific issues relevant to this project. The concrete 
slabs were constructed to illustrate the ability of GPR to locate and visualize features in the slab. 
See Figure 3. The ruler shown on the slab is 36 inches long. 

Figures 4 and 5 illustrate the manner in which the GPR information can be presented. Individual 
transects can be inspected for the signals that come from specific objects that differ in dielectric 
constant. In this instance, Figure 4 shows a hyperbolic signature near the center of the figure. 
This signature is commonly observed for a cylindrical object; in this instance, the signal is due to 
the rebar in the slab. Figure 5 illustrates how the use of orthogonal transects can enhance the 
visualization of the embedded item. The model shown in Figure 5 is a good representation of the 
actual placement (depth and length) of steel rebar in the slab. 

Figure 3. Slab containing crossed reinforcing bars (3/8-inch nominal diameter) 

Figure 4. Result of two GPR transects across the slab (the hyperbolae are due to the steel) 
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Figure 5. Three-dimensional visualization of the GPR survey (note: rebar is colored red) 

The results from the concrete and mortar slabs containing reactive aggregate were less dramatic. 
Transects from the concrete slab suggested that a moisture gradient was developing in the 
concrete slab. This was observed near the region in which the reactive aggregate was placed (see 
Figure 6). Cores extracted from the slab indicated that the fused quartz aggregate was exhibiting 
cracking caused by ASR; however, the cracking was not observed on the surface of the slab. 
Since the coring operation penetrated through the region of reactive aggregate in the slab, the 
experiment was effectively terminated because water now had access to the center of the slab. 
Therefore, additional studies (the mortar studies) were initiated to study the issue in more detail. 

Figure 6. Possible detection of moisture gradients due to ASR expansion 

The mortar studies were conducted with better experimental control. Expansion was measured 
via mortar bar expansion tests, so the slabs did not need to be cored. In addition, the mortar slabs 
were constructed with high-alkali cement to accelerate cracking. The mortar bars expanded 
rapidly (see Figure 7) and, after about five months of curing, the slab showed macroscopic 
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surface cracking (see Figure 8). The control specimens did not exhibit distress during the 
experiment. Unfortunately, the results of the GPR scans were still not conclusive. This was 
consistent with the behavior observed at site 3 (P 73). Perhaps uniform expansion is not  
measurable with GPR. More experimentation is needed before firm conclusions can be made.  

ASR Pads for MRD Project 
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Figure 7. Mortar bar expansion versus time for ASR cracking experiments 

Figure 8. Surface cracking on the specimen containing ASR-reactive aggregate 

14 




Summary of Results from Visual Inspection Studies 

Mandli Communications, Inc., agreed to perform an extended field demonstration of their PPS. 
The system was integrated into the existing Iowa DOT video log van. The van was upgraded 
with the new device and delivered to the Iowa DOT in early November 2002. However, the 
firmware of the PPS system did not perform according to specifications and the field 
demonstration was postponed until the firmware problems were fixed. This delay, coupled with 
the onset of winter weather, caused the study to be transferred into the current phase (Phase 2) of 
this project. 

The second field demonstration of the PPS system was conducted in early July 2003. The 
hardware functioned much better during the second demonstration; however, there were still 
some issues. First, a computer operating system error restricted the maximum data collection 
time to about eight minutes. This allowed researchers to collect data from only the first five sites 
listed in Table 3. Secondly, the system did not function properly unless the data collection speed 
was greater than about 25 to 30 mph. In fact, faster speeds tended to produce better data. The 
data collected was not optimal, and some issues had to be resolved prior to rutting and ride 
calculations. However, the demonstration was successful in that it created over three gigabytes 
of field data from real road sites. Data reduction was performed using Roadview 3D software, a 
web-based interactive software package that allows users to browse the data to locate features of 
interest. The features of interest can then be manipulated to evaluate the severity of the feature. 
The interpretation is rather lengthy and could probably be automated by a series of macros that 
search for specific types of perturbations in the data. However, such features were not available 
in 2003. Distress was easily located at sites 1, 2, and 3. Only minor distress was noted at site 4 
(the control road). 

The third field demonstration of the Mandli system was performed in July 2004. This time, the 
Iowa DOT video log van had been modified to support both the PPS system and the downward 
imaging system. In addition, DOT staff operated the van during the data collection process. Data 
was only collected from sites 1, 2, and 5 listed in Table 3. The data was collected without any 
apparent problems. However, Mandli expressed concern about some inconsistencies in the way 
the data had been collected (Smadi 2005). Mandli eventually returned to Iowa in September 
2004 to collect from the sites again; however, this time only site 5 from Table 3 was included in 
the survey. Most of the concerns about the data pertained to engineering-related indices that 
would be calculated from the data (International Roughness Index, etc.). Since this project was 
only looking for a proof-of-concept acceptance based on visualization of distress (cracking, 
spalling, etc.) the concerns did not appear relevant. Hence, the author decided to use the less-
than-optimal data collected in July 2004 because it had been collected from routes subjected to 
GPR surveys. Data analysis was performed using an enhanced version of Roadview 3D (Mandli 
2005). The program operated on an Apple Macintosh platform and was more robust than the 
earlier version. The ability to integrate the PPS data stream with the Photolog information and 
GPS information made the program more user friendly. In addition, the downward imaging 
system provided excellent information about pavement distress. Hence, this system performed 
even better than the one tested in 2003 (even though the data was not optimal). 
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Further Discussion on Combining Visual Inspection with GPR 

One of the objectives of this research project pertained to the feasibility of combining the results 
of GPR with the visual inspection system to provide a simpler way to visualize pavement 
distress. Although this task may sound simple, working with the surveys conducted in this study 
has shown that such an undertaking is quite complex. There are several reasons why this is so. 
First, the data was collected using computers that utilize different operating systems (Apple OS 
versus Windows OS). Data exchange is not impossible, but it will take a considerable amount of 
development. Secondly, for exact agreement in the data stream, data must be collected 
simultaneously (or at least on a single vehicle with a good distance measuring instrument). An 
alternative solution would be to designate and measure reference points on the survey. However, 
this solution is also very time consuming. All surveys conducted in this project were collected at 
different times with different distance measuring devices, and would therefore require a 
significant amount of processing to be combined accurately.  
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SUMMARY AND CONCLUSIONS 

In summary, two techniques were evaluated with proof-of-concept testing for their ability to help 
detect materials-related distress in portland cement concrete pavements. The two techniques 
selected for evaluation were GPR and a visual inspection system provided by Mandli 
Communications, Inc. Both systems were able to enhance the ability of pavement engineers to 
detect distress. Thus, both were considered to have passed the proof-of-concept trials. 
Importantly, however, neither method can currently diagnose the presence of materials-related 
distress. Rather, both techniques only detected the symptoms of materials-related distress; the 
actual diagnosis still relied on coring and subsequent petrographic examination. Both 
technologies are currently in a rapid state of development and the future appears bright. Perhaps 
this limitation will be overcome as the technologies advance and mature. 

GPR surveys were performed on four different portland cement concrete pavements using 
several different systems. The surveys produced test results capable of identifying subsurface 
distress in two of the three sites that contained materials-related distress. The systems failed to 
detect distress in one pavement that exhibited extensive cracking. This anomaly was linked to 
the presence of excessive moisture in the pavement site. The survey conducted on the control 
(distress-free) pavement  indicated no apparent distress. Note, that only ground-coupled antennas 
were employed in this study. Several details specific to the use of the GPR systems can be 
summarized as follows: 

•	 Materials-related distress is normally associated with differences in moisture content 
in the pavement. Hence, often only subtle features are produced in the GPR signal. 

•	 Vehicle speed is important and a compromise needs to be made between detection 
and efficiency. In most instances, slower speeds enhance the ability to locate 
materials-related distress. This ability also depends on the extent of the distress. 

•	 Typically, closer coupling of the antenna to the ground improves the GPR signal, and 
therefore improves the ability to locate the moisture gradients that occur with 
materials-related distress. However, one must also weigh the consequences of hitting 
an object during a survey. Again, this is a compromise between utility and detection. 

Mandli Communications, Inc., performed extended field demonstrations of their pavement 
evaluation system. The initial system used consisted of a PPS. The system was integrated into 
the existing Iowa DOT video log van. A second system, consisting of a PPS and a downward 
imaging system (dual line-scan cameras, but without a lighting system), was also tested. Again, 
the systems were integrated into the Iowa DOT video log van. Both systems were capable of 
collecting data at highway speeds (more than 55 mph). Surveys were conducted on five different 
portland cement concrete pavements; both systems provided excellent capability of detecting 
surface cracking on pavement slabs. Post-processing of the data has been improved dramatically 
in the recent version of the analysis software. 
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APPENDIX 1: STANDARD OPERATING PROCEDURES FOR GPR SURVEYS 
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PROCEDURE FOR SIR-20 GPR, LINEAR SURVEY 

1.	 Power 
A.	 Plug appropriate power adapter into EXTERNAL POWER IN port. 
B.	 Turn on computer, so it boots as you set up. 

2.	 Antennas 
A.	 Set up antennas on mountings for data collection. 
B.	 Remove caps from TRANSDUCER 1 and end of blue antenna cable, then attach cable to 

TRANSDUCER 1. 
C.	 Attach other end of antenna cable to antenna. 
D.	 Repeat for second antenna, if necessary. 

3.	 Odometer (measuring wheel) 
A.	 Attach odometer to mounting, making sure that the protective plastic shield near the wheel’s axle 

is facing down. 
B.	 Plug odometer cable into either an antenna’s four-pin port, or the SIR-20 unit’s SURVEY 

WHEEL port, either will work. 

4.	 Software setup 
A.	 Open SIR-20 program from desktop. Click once to clear title screen. 
B.	 Linear units start out set as feet, but can be changed to meters in View>Customize. 
C.	 Select File>New, or find the toolbar button for the same function. 
D.	 Enter file name and select directory to which the file will be saved. 

5.	 Odometer calibration 
A.	 After Create New Project window, the Data Collection Mode window will appear. Select Survey 

wheel, and then click on the Calibrate button. 
B.	 Select calibration distance. 
C.	 Position wheel on start mark.  
D.	 Click Start then move wheel forward until the distance is reached. Click Save. 

6.	 Parameterization and Macro selection 
A.	 Change Config Name to 1CHAN or 2CHAN depending on the number of channels (antennas) 

being used. 
B.	 Configure the two Chan tabs below with correct frequency. 
C.	 If it is known, fill in the Dielectric Constant, then determine the desired scans/ft (or meter) and 

number of feet per mark. Marks do not change the data, but aid interpretation. 
D.	 Click OK and select the appropriate macro. If two antennas are being used, then pick a macro 

appropriate to one of them.  
E.	 Once the macro is selected, the antennas will initialize and the scanning window will open. 

Scanning has not begun at this point, it is only running the antennas. 

7.	 Begin scanning 
A.	 Place the antennas at the starting point. 
B.	 Click on the green button (looks like a ‘play’ button on a CD player) to begin scanning. 
C.	 Collect data. 
D.	 When data collection is finished, click the red button with the white dot to stop and save. If the 

red button with the white X is clicked, then all data will be erased. 
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PROCEDURE FOR SIR-20 GPR, 3-D SURVEY 

1.	 Set up antennas, survey wheel, and computer as in linear survey. 

2.	 Software setup 
A.	 Open SIR-20 program from the desktop. Click to clear the title screen. 
B.	 Linear units start out as feet, but can be changed to meters in View>Customize. 
C.	 Select File>New, or find the toolbar button for the same function. 
D.	 Enter file name and select the directory to which the file will be saved. Check the Create 3Dfile 

box. 
E.	 Data collection mode must be Survey Wheel 

3.	 Odometer Calibration – See above. 

4.	 Parameterization 
A.	 On the Configuration tab, the setup is the same as above. Do not forget to look over this tab, 

RADAN will have a different setup than the previous study as its default. 
B.	 On the Geometry tab, set up the dimensions of the study area. The Y-axis spacing should be set 

so that there are around twenty (20) transects inside the survey grid.  
C.	 The Grid Outline box is important especially when the survey is going to be combined with 

another survey using Super3D later to make a single, larger survey. The dimensions for the grid 
must overlap so that there is a transect in common with the adjacent survey. 

D.	 Once all boxes are correctly filled, click the Apply Regular Grid button, then OK to continue. 
E.	 Select a macro as above. 

5.	 Data Collection 
A.	 Along with the survey window, the Antenna Position window will open. This shows the location 

of the antenna on the survey grid. A red arrow shows the antenna’s location along the Y-axis and 
a black square shows the antenna’s position along the X-axis. 

B.	 Click the Test button on the Antenna Position window. The red arrow will move to the first 
transect on the grid, and the Test button will change to say Set. Click the two arrow buttons in the 
Antenna Position window to adjust the red arrow to the desired location. 

C.	 Position the antenna at the starting position and click the green button (looks like the ‘play’ 
button on a CD player) 

D.	 Move the antenna along the transect. As the antenna moves, the black square will move along the 
transect. Do not be alarmed if the black dots do not disappear, this can happen sometimes. At the 
end of the transect, the scanning will stop automatically.  

E.	 Click the arrow buttons on the Antenna Position window to reposition the red arrow to the correct 
transect. Return the antenna to the start position. 

F.	 At this time, the Set button on the Antenna Position window will be red. Click the Set button, and 
soon it will change back to green. This is the signal to start scanning this new transect.  

G.	 Repeat steps D, E, and F until the survey is finished. 
H. Click the red button with the white dot to stop and save. If the red button with the white 

X is clicked, then all data will be erased. 
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